
Ulead PhotoImpact 3.02 Special Edition Read Me file

April 1997: Ulead PhotoImpact 3.02 Special Edition

Review the whole file (allows you to print all topics at one time)
PhotoImpact as a server in OLE applications
Using Program Manager as the Windows 95 shell
Uninstall
Running Ulead PhotoImpact 3.02 on Windows NT
Using Ulead PhotoImpact 3.02 for editing linked objects
Using Kai's Power Tools and other Adobe Photoshop plug-in filters
Customizing file format support
FlashPix file format support
Online User Guide
Copyrights
Contacting Ulead



PhotoImpact as a server in OLE applications

Before you can use PhotoImpact as a server in OLE applications, you must start and close the program 
after installation. This is to update the registration database and ensure that all links and paths are in 
order. You only need to do this one time.

Start PhotoImpact now



Using Program Manager as Windows 95 shell

If you are using Program Manager as your Windows 95 shell during installation, the PhotoImpact 
program group may not be created properly. This is because Program Manager does not fully support 
long filenames. You can still run PhotoImpact programs from Program Manager.



Uninstall

Ulead PhotoImpact 3.02 has an uninstall utility. To ensure proper behavior, do not install different Ulead 
32-bit programs in the same folder. (It is OK to overwrite previous versions of PhotoImpact with a later 
version.) Otherwise you may accidentally delete essential files for the programs you wish to retain.



Running Ulead PhotoImpact 3.02 on Windows NT 3.51

Ulead PhotoImpact 3.02 is designed to take full advantage of the 32-bit capabilities of Windows 95 and 
Windows NT. However, due to some built-in differences between Windows 95 and Windows NT, 
PhotoImpact may behave differently when running under Windows NT.

1. Because Windows NT does not support the flat thunk which is supported in Windows 95, some 
PhotoImpact functions in Windows NT are disabled, including support for all 16-bit APS (Adobe 
Photoshop) compatible plug-in modules, such as Kai's Power Tools 2.0.



Using Kai's Power Tools and other Adobe Photoshop plug-in filters

PhotoImpact supports Kai's Power Tools and other 16- and 32-bit Adobe Photoshop (APS) compliant 
plug-in effect filters under Windows 95. By performing the installation procedure below, you can use 
these third party special effect filters in PhotoImpact.

1. Close all Ulead PhotoImpact programs.
2. Install the APS plug-in filters according to their accompanying documentation.
3. Once the APS plug-in filters are properly installed, add the following lines to the ULEAD32.INI file, 

found in the Windows folder:
[PLUG IN]
PLUGINDIR1=C:\KPT

where "C:\KPT" is the folder where Kai's Power Tools is installed. (If you are using another APS 
compliant plug-in filter, use the folder name for that filter.) If you have multiple APS plug-in filter 
folders, increment the number of the headings as follows:

[PLUG IN]
PLUGINDIR1=C:\KPT
PLUGINDIR2=C:\EFFECTS
PLUGINDIR3=C:\FILTERS

4. After you change the ULEAD32.INI file, additional menu items appear in the Effect menu of 
PhotoImpact next time you start it. For example, if you installed Kai's Power Tools, "KPT Extensions" 
and "KPT Filters" are added. 



Customizing file format support

Ulead PhotoImpact 3.02 employs an open file format architecture to support file reading and writing 
operations. Additional File Input Output (FIO) modules can be added to the FIO folder to enable reading
new file formats. This version of PhotoImpact comes with over thirty modules which are placed in the 
FIO folder under the program folder.



FlashPix file format support

Ulead PhotoImpact 3.02 now supports opening and saving images to the FlashPix file format which was
jointly developed by Eastman Kodak Company, Microsoft Corporations, Hewlett-Packard Company, and
Live Picture, Inc. One of the key features of this format is that the file stores several sizes for images 
inside it so that the image always looks its best when printed or displayed, regardless of the output 
device size or resolution. 

Notes
1. When saving images, please be aware that the largest size possible for the saved file will be the same

as the currently active image.
2. PhotoImpact does not retain image transformation data when saving.

For example, if you open a FlashPix image whose original largest dimensions are 640 x 480 pixels at 
a size of 320 x 240 pixels and then save it again using the FlashPix format, the largest dimensions 
possible for the resulting image will be 320 x 240 pixels. To be safe, always open FlashPix images at 
their largest dimensions. 

3.FlashPix file format currently only supports the single-byte operating system. Please note that if you 
save a FlashPix image with a double byte file name, or put the image into a double byte folder, it will 
cause a program error.

Opening FlashPix images
You can open files using the FlashPix format the same way that you open any other images in 
PhotoImpact. When you select a FlashPix file or the format from the “Files of type” list in the Open 
dialog box, the Options button becomes active. If you wish to explicitly state the conditions for opening 
the selected file(s), click Options to see the FlashPix Open Options dialog box:

Dimensions:    Select the desired dimensions for the file. If you make and save using the 
FlashPix format, these will be the largest dimensions of the saved file..

Apply existing transformations:    Select this option if changes were made to the image by a 
program that supports saving image transformation data. Clear this option if you wish to restore the image
to its original conditions 

Note:    Remember that Ulead PhotoImpact does not retain transformation data when saving.

Setting PhotoImpact defaults for opening FlashPix images
1. From the File menu, choose Open.
2. In the Open dialog box, select FPX (Kodak FlashPix) from the Files of type drop down list.
3. Click Options. (Do not select any file names.)
4. In the resulting dialog box select the desired size from the Multiple files and default dimensions list.
5. Select or clear “Apply existing transformations” and click OK

Now any time you open a FlashPix image, the largest dimensions will be used. If you wish to open a 
particular image using smaller dimensions, in the Open dialog box, select the image to open and then 
click Options. In the FlashPix Options dialog box select the desired size for the image from the 
Dimensions drop down list.

Saving images using the FlashPix format
When saving images using the FlashPix Format, the Save dialog box enables the Options button for 
opening the FPX Save Options dialog box:

Create multiple dimensions Select to create several sizes of the same image in the file. For 
programs that support the FlashPix format, this enables them to present the image with the highest 
possible quality and accuracy. The largest dimensions for the file will be those of the image in the 



PhotoImpact workspace.
Include calibration comment in the header Select to add a flag in the file’s header that 

indicates the image is calibrated.
Compression Select JPEG if disk space or band width for the file is a serious concern. This will 

result in significant file size savings. Remember that JPEG compression is a lossey method. For more 
information about JPEG compression, see the PhotoImpact help.

Summary information Add keywords, comments, and other proprietary information to the file.



Using Ulead PhotoImpact 3.02 for editing linked objects

You can use Ulead PhotoImpact 3.02 as an image editor for linked objects in a container program. 
When a container document is set to automatically link, any changes to the object using PhotoImpact 
3.02 are immediately reflected on the object in the container document. If you close the image in 
PhotoImpact 3.02 without saving it, the edited version remains in the container document. To return the 
image to its last saved state, discarding all changes that were not saved to the image file, right click on 
the object and choose "Update Link."



Online User Guide

A copy of the complete PhotoImpact User Guide is included on the program CD as an Adobe Acrobat 
file. You may open this file and read the manual online or print it out for reading away from your 
computer. The manual is available in three languages, English French, and German according to the 
following folder structure:

English \\Document\Manuals\Pimpact3\English\Userguide.pdf
French \\Document\Manuals\Pimpact3\French\Userguide.pdf
German \\Document\Manuals\Pimpact3\German\Userguide.pdf
Italian \\Document\Manuals\Pimpact3\Italian\Userguide.pdf
Spanish \\Document\Manuals\Pimpact3\Spanish\Userguide.pdf

To view this document, you must first install the Adobe Acrobat reader on your system. A copy of this 
program is on your CD in the \\Document\Acrobat folder. 

For the English, Italian, and Spanish versions of the guide, run Reader.exe
For the French version, run Acrfre.exe
For the German version, run Acrger.exe

You may also install the manual onto your hard disk for easy access when the CD is not available. To 
do so, perform a custom installation and select the Online manual option. The manual requires 
approximately 16 to 19 MB depending on the language version.



Copyrights

1. Ulead PhotoImpact 3.02 SE, PhotoImpact SE
© 1992 - 1997 Ulead Systems, Inc.
All rights reserved

2. Ulead PhotoImpact 3.02 SE, PhotoImpact Album SE
© 1992 - 1997 Ulead Systems, Inc.
All rights reserved

3. Ulead PhotoImpact 3.02 SE, PhotoImpact Viewer SE
© 1994 - 1997 Ulead Systems, Inc.
All rights reserved

4. Ulead PhotoImpact 3.02 SE, PhotoImpact Explorer SE
© 1997 Ulead Systems, Inc.
All rights reserved

5. Ulead PhotoImpact 3.02 SE, Ulead Quick Access SE
© 1997 Ulead Systems, Inc.
All rights reserved

6. Kodak FlashPix
© 1996 Eastman Kodak Company
All rights reserved

7. KPT and KAI’S POWER TOOLS
© 1994-1996 Metatools, Inc.
All rights reserved

8. The Progressive JPEG File Input Output Module is based in part on the work of the Independent 
JPEG Group.

All other trademarks are the property of their respective holders.



Contacting Ulead

Click below for information about a distributor near you.

          North and South America  
International
German Support & Upgrade Center
French Support & Upgrade Center



North and South America
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502
Tel: (310) 523-9393
Fax: (310) 523-9399
E-Mail: mkt@ulead.com



German Support & Upgrade Center
Digitale Video- und Bildbearbeitung Kexel
Am Struethchen 8
D-56412 Grossholbach, Germany
Tel: +49-2602-5685
Fax: +49-2602-16812



French Support & Upgrade Center
Ulead Support Center
154 rue des Pyrénés
75020 Paris
France
Tel: +33 1 44-93-87-20
Fax: +33 1 40 09 86 36
E-Mail: graphics@imaginey.fr



International
Ulead Systems, Inc.
10F, 111 Tung Hsing Street
Taipei, Taiwan, R.O.C.
Tel: 886 (2) 764-8599
Fax: 886 (2) 764-9599
E-Mail: mkt@ulead.com.tw
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1. PhotoImpact as a server in OLE applications

Before you can use PhotoImpact as a server in OLE applications, you must start and close the program 
after installation. This is to update the registration database and ensure that all links and paths are in 
order. You only need to do this one time.

Start PhotoImpact now

2.    Using Program Manager as the Windows 95 shell

If you are using Program Manager as your Windows 95 shell during installation, the PhotoImpact 
program group may not be created properly. This is because Program Manager does not fully support 
long filenames. You can still run PhotoImpact programs from Program Manager.

3.    Uninstall

Ulead PhotoImpact 3.02 has an uninstall utility. To ensure proper behavior, do not install different Ulead 
32-bit programs in the same folder. (It is OK to overwrite previous versions of PhotoImpact with a later 
version.) Otherwise you may accidentally delete essential files for the programs you wish to retain.

4.    Running Ulead PhotoImpact 3.02 on Windows NT 3.51

Ulead PhotoImpact 3.02 is designed to take full advantage of the 32-bit capabilities of Windows 95 and 
Windows NT. However, due to some built-in differences between Windows 95 and Windows NT, 
PhotoImpact may behave differently when running under Windows NT.

1. Because Windows NT does not support the flat thunk which is supported in Windows 95, some 
PhotoImpact functions in Windows NT are disabled, including support for all 16-bit APS (Adobe 
Photoshop) compatible plug-in modules, such as Kai's Power Tools 2.0.

5.    Using Ulead PhotoImpact 3.02 for editing linked objects

You can use Ulead PhotoImpact 3.02 as an image editor for linked objects in a container program. 



When a container document is set to automatically link, any changes to the object using PhotoImpact 
3.02 are immediately reflected on the object in the container document. If you close the image in 
PhotoImpact 3.02 without saving it, the edited version remains in the container document. To return the 
image to its last saved state, discarding all changes that were not saved to the image file, right click on 
the object and choose "Update Link."

6.    Using Kai's Power Tools and other Adobe Photoshop plug-in filters

PhotoImpact supports Kai's Power Tools and other 16- and 32-bit Adobe Photoshop (APS) compliant 
plug-in effect filters under Windows 95. By performing the installation procedure below, you can use 
these third party special effect filters in PhotoImpact.

1. Close all Ulead PhotoImpact programs.
2. Install the APS plug-in filters according to their accompanying documentation.
3. Once the APS plug-in filters are properly installed, add the following lines to the ULEAD32.INI file, 

found in the Windows folder:
[PLUG IN]
PLUGINDIR1=C:\KPT

where "C:\KPT" is the folder where Kai's Power Tools is installed. (If you are using another APS 
compliant plug-in filter, use the folder name for that filter.) If you have multiple APS plug-in filter 
folders, increment the number of the headings as follows:

[PLUG IN]
PLUGINDIR1=C:\KPT
PLUGINDIR2=C:\EFFECTS
PLUGINDIR3=C:\FILTERS

4. After you change the ULEAD32.INI file, additional menu items appear in the Effect menu of 
PhotoImpact next time you start it. For example, if you installed Kai's Power Tools, "KPT Extensions" 
and "KPT Filters" are added. 

7.    Customizing file format support

Ulead PhotoImpact 3.02 employs an open file format architecture to support file reading and writing 
operations. Additional File Input Output (FIO) modules can be added to the FIO folder to enable reading
new file formats. This version of PhotoImpact comes with over thirty modules which are placed in the 
FIO folder under the program folder.

8.    FlashPix file format support

Ulead PhotoImpact 3.02 now supports opening and saving images to the FlashPix file format which was
jointly developed by Eastman Kodak Company, Microsoft Corporations, Hewlett-Packard Company, and
Live Picture, Inc. One of the key features of this format is that the file stores several sizes for images 
inside it so that the image always looks its best when printed or displayed, regardless of the output 
device size or resolution. 

Notes
1. When saving images, please be aware that the largest size possible for the saved file will be the same

as the currently active image.
2. PhotoImpact does not retain image transformation data when saving.

For example, if you open a FlashPix image whose original largest dimensions are 640 x 480 pixels at 
a size of 320 x 240 pixels and then save it again using the FlashPix format, the largest dimensions 
possible for the resulting image will be 320 x 240 pixels. To be safe, always open FlashPix images at 
their largest dimensions. 



3.FlashPix file format currently only supports the single-byte operating system. Please note that if you 
save a FlashPix image with a double byte file name, or put the image into a double byte folder, it will 
cause a program error.

Opening FlashPix images
You can open files using the FlashPix format the same way that you open any other images in 
PhotoImpact. When you select a FlashPix file or the format from the “Files of type” list in the Open 
dialog box, the Options button becomes active. If you wish to explicitly state the conditions for opening 
the selected file(s), click Options to see the FlashPix Open Options dialog box:

Dimensions:    Select the desired dimensions for the file. If you make and save using the 
FlashPix format, these will be the largest dimensions of the saved file..

Apply existing transformations:    Select this option if changes were made to the image by a 
program that supports saving image transformation data. Clear this option if you wish to restore the image
to its original conditions 

Note:    Remember that Ulead PhotoImpact does not retain transformation data when saving.

Setting PhotoImpact defaults for opening FlashPix images
1. From the File menu, choose Open.
2. In the Open dialog box, select FPX (Kodak FlashPix) from the Files of type drop down list.
3. Click Options. (Do not select any file names.)
4. In the resulting dialog box select the desired size from the Multiple files and default dimensions list.
5. Select or clear “Apply existing transformations” and click OK

Now any time you open a FlashPix image, the largest dimensions will be used. If you wish to open a 
particular image using smaller dimensions, in the Open dialog box, select the image to open and then 
click Options. In the FlashPix Options dialog box select the desired size for the image from the 
Dimensions drop down list.

Saving images using the FlashPix format
When saving images using the FlashPix Format, the Save dialog box enables the Options button for 
opening the FPX Save Options dialog box:

Create multiple dimensions Select to create several sizes of the same image in the file. For 
programs that support the FlashPix format, this enables them to present the image with the highest 
possible quality and accuracy. The largest dimensions for the file will be those of the image in the 
PhotoImpact workspace.

Include calibration comment in the header Select to add a flag in the file’s header that 
indicates the image is calibrated.

Compression Select JPEG if disk space or band width for the file is a serious concern. This will 
result in significant file size savings. Remember that JPEG compression is a lossey method. For more 
information about JPEG compression, see the PhotoImpact help.

Summary information Add keywords, comments, and other proprietary information to the file.

9.    Online User Guide

A copy of the complete PhotoImpact User Guide is included on the program CD as an Adobe Acrobat 
file. You may open this file and read the manual online or print it out for reading away from your 
computer. The manual is available in five languages, (English French, German, Italian, and Spanish), 
according to the following folder structure:

English \\Document\Manuals\Pimpact3\English\Userguide.pdf
French \\Document\Manuals\Pimpact3\French\Userguide.pdf
German \\Document\Manuals\Pimpact3\German\Userguide.pdf



Italian \\Document\Manuals\Pimpact3\Italian\Userguide.pdf
Spanish \\Document\Manuals\Pimpact3\Spanish\Userguide.pdf

To view this document, you must first install the Adobe Acrobat reader on your system. A copy of this 
program is on your CD in the \\Document\Acrobat folder. 

For the English, Italian, and Spanish versions of the guide, run Reader.exe
For the French version, run Acrfre.exe
For the German version, run Acrger.exe

You may also install the manual onto your hard disk for easy access when the CD is not available. To 
do so, perform a custom installation and select the Online manual option. The manual requires 
approximately 16 to 19 MB depending on the language version.

10.    Copyrights

1. Ulead PhotoImpact 3.02 SE, PhotoImpact SE
© 1992 - 1997 Ulead Systems, Inc.
All rights reserved

2. Ulead PhotoImpact 3.02 SE, PhotoImpact Album SE
© 1992 - 1997 Ulead Systems, Inc.
All rights reserved

3. Ulead PhotoImpact 3.02 SE, PhotoImpact Viewer SE
© 1994 - 1997 Ulead Systems, Inc.
All rights reserved

4. Ulead PhotoImpact 3.02 SE, PhotoImpact Explorer SE
© 1997 Ulead Systems, Inc.
All rights reserved

5. Ulead PhotoImpact SE 3.02, Ulead Quick Access SE
© 1997 Ulead Systems, Inc.
All rights reserved

6. Kodak FlashPix
© 1996 Eastman Kodak Company
All rights reserved

7. KPT and KAI’S POWER TOOLS
© 1994-1996 Metatools, Inc.
All rights reserved

8. The Progressive JPEG File Input Output Module is based in part on the work of the Independent 
JPEG Group.

All other trademarks are the property of their respective holders.

11.    Contacting Ulead:

North and South America
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502
Tel: (310) 523-9393
Fax: (310) 523-9399
E-Mail: mkt@ulead.com

International
Ulead Systems, Inc.



10F, 111 Tung Hsing Street
Taipei, Taiwan, R.O.C.
Tel: 886 (2) 764-8599
Fax: 886 (2) 764-9599
E-Mail: mkt@ulead.com.tw

German Support & Upgrade Center
Digitale Video- und Bildbearbeitung Kexel
Am Struethchen 8
D-56412 Grossholbach, Germany
Tel: +49-2602-5685
Fax: +49-2602-16812

French Support & Upgrade Center
Ulead Support Center
154 rue des Pyrénés
75020 Paris
France
Tel: +33 1 44-93-87-20
Fax: +33 1 40 09 86 36
E-Mail: graphics@imaginet.fr




